
happen. 1) the real es-
tate of the chip has to 
shrink and 2) the 
traces (like wires) inside the chip must 
be narrower. (Both of these reduce 
capacitance which allows faster opera-
tion.) With the technologies at hand 
that can be produced at a reasonable 
cost, the maximum speeds have more 
or less been reached. So to keep the 
money pump running, 'er I mean to 
keep increasing technology, the CPU 
manufacturers went to multiple proc-
essors (cores). But here's the dirty lit-
tle secret. Unless the operating system 
being run takes advantage of multi-
core processors, they do nothing for 
you. 
 
The future versions of Windows will 
no doubt make use of multi-core proc-
essors and I'd be surprise if some ver-
sions of Linux didn't use them al-
ready. Today when you run two things 
at once the PC actually runs one, 
stops, runs the second, stops, goes to 
the first, and so on. All this happens 
so quickly that the two programs both 
appear to running simultaneously. So 
let's say your PC can actually do two 
things at one time which is what the 
multi-cores allow it to do, how many 
times do you actually do two or more 
things at the same time? The most 
common example I can think of is 
downloading something from the web 
and typing something into a document 
or a spreadsheet. Neither of these   

(Continued on page 5) 
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STERLING  HEIGHTS  COMPUTER  CLUB 
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Sterling  Heights,  MI   48311-0385 $3.00 

“Tablets, eReaders, and 

SmartPhones” presented 

by Eric Hayes of the Royal 

Oak Public Library 

          The President’s Pen The President’s Pen The President’s Pen The President’s Pen  
                 by Don VanSyckel 

H 
APPY NEW YEAR!! 
 
 

I trust each of you had a Merry Christ-
mas. Hopefully you were good and 
Santa left all you wanted under your 
tree. 
 
It's hard to believe 2011 slipped by as 
quickly as it did and December was 
just a blip. It seems like I was writing 
the December President's Pen just a 
few days ago. Between the parties, 
preparing for Christmas, visiting 
friends, and all the standard monthly 
activities we hardly had time to catch 
our breath. 
 
Since I'm writing this before Christ-
mas to make the publishing schedule 
set up by the SHCC newsletter editor, 
I can't tell you anything about what I 
got for Christmas. Although I gener-
ally don't get much since like so many 
other people I get thing throughout the 
year so no need for lots at Christmas. 
This has the advantage of leaving one 
unburdened with the rush of Christ-
mas and you can think more about the 
real reason for the season. 
 
I thought I'd touch on the multi-core 
processors this month. There are 
quad-processor CPUs available now. 
What does this mean and what can it 
do for you? First a little background, 
to make a CPU or any digital chip run 
faster two major factors have to     
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Guests and visitors are welcome. People can attend any SHCC meetings during two consecutive months before decid-

ing to become a member or not.  Meetings include the main meeting and SIGs.  July and August don't count since there 

is no main meeting.  Membership includes admission to all SHCC functions and the newsletter.  Membership is open to 

anyone.  It is not limited to the residents of Sterling Heights. 

  DUES:   $25/YEAR 

Four  Month Meeting  Schedule:Four  Month Meeting  Schedule:Four  Month Meeting  Schedule:Four  Month Meeting  Schedule:    

CLUB ADDRESS:  PO Box 385,  Sterling Heights, MI  48311-0385 
CLUB E-MAIL ADDRESS:  Info@SterlingHeightsComputerClub.org 
CLUB WEB PAGE: http://www.SterlingHeightsComputerClub.org 

As a member of SHCC, you can attend 
meetings of other clubs where we have 
reciprocating membership agreements, at 
no charge. 
 

Computer Club of Marysville and 

Port Huron (COMP) 
Time:   1st Wednesday, 7:00PM 
Place: Mackenzie Bldg, Room 201, St 
Clair Community College, Clara E 
McKenzie Library-Science Building, 

323 Erie St. 
Port Huron, (810) 982-1187 
Web Page: http://www.bwcomp.org 
Reciprocating: Yes 
 
 
 

Newsletter  submissions  are  due  10  days before the club meeting, but the 
earlier the better. They should be sent to : 
       WYSIWYG Publisher 
       5069 Fedora,  Troy, MI 48098 
OR at the e-mail addresses:  newsletter@SterlingHeightsComputerClub.org 

Unless stated otherwise, all materials contained in this newsletter are copyrighted 
by the Sterling Heights Computer Club. License is hereby granted to other clubs 
(non-profit) to reprint with credit. 

The WYSIWYG was printed by STERLING PRINTING  AND 
GRAPHICS, located at  35976 Mound, Sterling Heights, MI 48312. 

South Eastern Michigan Computer 

Organization (SEMCO) 
Time:    2nd Sunday at 1:30PM 
Place: The Engineering Society of 
Detroit 20700 Civic Center Dr. South-
field,  MI 48076 Suite 450 4th Floor 
Web page: http://www.semco.org 
Reciprocating: Yes 
 
The OPC (Older Persons Com- 
mission) Computer Club  
Time:   Every Tuesday at 10:00  
Place:  OPC in Rochester   
       248-656-1403.  
Web page: http://www.geocities.com/
Heartland/Village/1904/ 
No cost for residents to join or attend 
meetings. $150 fee for non-residents 
Reciprocating: No 

Other Computer Clubs:Other Computer Clubs:Other Computer Clubs:Other Computer Clubs:    

JANUARY 2012 

4  -  SHCC -  “Tablets, 

eReaders and Smart- 

Phones” presented by 

Eric Hayes of the Royal 

Oak Public Library 
5  - COMP meeting 
9  - SEMCO meeting 
 
 
  

FEBRUARY 2012 
7  -  SHCC -  Main Meeting 
8  - COMP meeting 
12- SEMCO meeting 
 
 

MARCH 2012 
6 -  SHCC -  Main Meeting 

7  - COMP meeting 
11- SEMCO meeting 
 
 
 
 

APRIL 2012 
3  -  SHCC -  Main Meeting 
4   - COMP meeting 
8  - SEMCO meeting 

Lindell Beck 
Ron Frederick 
Jerry Hess 
Rick Kucejko 
Patrick Little 
Sharon Patrick 
John Rady 
Rick Schummer 
Ed Trombley 
Don VanSyckel 
Jack Vander-Schrier 
      (Call Jack after noon) 

586-939-4278 
586-294-5687 
586-566-6166 
248-879-6180 
586-264-1497 
586-268-3626 
248-258-9515 
586-254-2530 
586-254-1172 
586-731-9232 
586-739-5952 
 

ljb48312@gmail.com 
frederic@gdls.com 
jhess@comcast.net 
rick@kucejko.com 
pblittle@wideopenwest.com 
espee37@att.net. 
john.rady@hotmail.com 
rick@rickschummer.com 
ejtrombley@comcast.net 
don@vansyckel.net 
jvanders@comcast.net 
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 If your e-mail or mail address 

changes, please e-mail:  

secretary@SterlingHeights Com-

puterClub.org 

� � � � � 

Discovering Windows 7Discovering Windows 7Discovering Windows 7Discovering Windows 7    
by Neil Stahfest, Vice President, Tacoma Area PC User Group, Washington 

NCStahfest@msn.com   www.tapcug.org 

� � � � � 

SSSSHCC Emergency HCC Emergency HCC Emergency HCC Emergency 

CaCaCaCannnncellationcellationcellationcellation    
    

I 
f a club meeting is canceled an 

email will be sent to members by 

an officer, or the coordinator if a 

SIG meeting, at least an hour before 

the scheduled start of the meeting.  If 

you have an issue with your email call 

one of the officers. Don't call too 

early, the decision might not be final-

ized yet.  All members are encouraged 

to keep the club up to date with their 

email address. 

DDDDoor Prizesoor Prizesoor Prizesoor Prizes    
 

T 
he SHCC offers door prizes at 

most regularly scheduled club 

meetings. In December the 

winners circle included: 

 

Ron Linsley won an external DVD/

CD rewriter 

 

Arnold Jarboe won a set of AV ca-

bles 

 

Ed Zaremba won a 3.5” card reader 

 

Paul Baecker won a 5” digital pic-

ture frame 

 

Ralph Osinski won a microphone 

stand 

 

Rick Kucejko won a MS Digital 

Image Software suite 

 

Paul Cozort won a PC cooling fan 

 

James Waldrop won a  computer 

cable 

M 
icrosoft Windows uses 

small files called device 

drivers to communicate 

with peripheral devices like printers 

and scanners. For example, when you 

use a word processing program and 

enter a line feed character, the code 

for a line feed must be translated to a 

code your printer understands to feed 

a new line. Drivers can be for a spe-

cific device or a family of devices like 

HP LaserJet printers. Over the years 

thousands of device drivers have been 

written. Windows 7 comes with many 

built-in drivers to simplify the instal-

lation when you plug in a new printer 

or scanner into your computer. If 

Windows 7 doesn’t have a driver for 

your device it asks you to provide one. 

This could be from a CD that came 

with your device or you can search the 

Internet for the right driver. 

 

So what if you can’t find a driver on 

the Internet?  Your best bet is to check 

the device manufacturer’s web site for 

Windows 7 drivers. If your device is 

old, however, the manufacturer may 

no longer support it and there may be 

no drivers for Windows 7. In that 

case, try looking for drivers for Win-

dows Vista or a similar model of the 

device. Ultimately, you may have to 

buy a replacement device. The good 

news is many new devices are faster, 

do more and are less expensive than 

the old ones. 

 

So what can you do if you have an old 

program that worked fine with Win-

dows XP but now runs poorly or 

maybe not at all with Windows 7?   

 

Well it turns out that Microsoft has 

thought of that and created something 

called a Windows compatibility mode. 

Using the compatibility mode you can 

tell it to run the program using the set-

tings for an earlier version of Win-

dows (like Windows XP), limit the set 

of colors displayed, change the screen 

resolution and other settings. There 

are two ways you can change the com-

patibility settings. You can use the Win-

dows Program Compatibility Trouble-

shooter or change them manually.   

 

To use the Program Compatibility Trou-

bleshooter, right-click on the program’s 

name or desktop shortcut and in the 

window that appears, right-click on 

Troubleshoot compatibility and follow 

the on-screen instructions. If you cannot 

install the program, locate the pro-

gram’s setup file, usually called Setup.

exe or Install.exe, click on Troubleshoot 

compatibility and follow the instruc-

tions that appear.   

 

To change program compatibility set-

tings manually, start by right-clicking 

on the program icon. At the bottom of 

the window that appears you will see 

Properties. Click on it and then click on 

the Compatibility. You can get a drop 

down list there of all the versions of 

Windows that you can select from, go-

ing back as far as Windows 95.      

 

Note that under Settings you can change 

colors, screen resolution, etc. Under 

Privilege Level you can restrict the pro-

gram to use by an administrator only 

and you can change settings for all us-

ers.  

 

After trying different program compati-

bility settings your program may still 

not work properly. If you have a really 

old program they may be a hardware 

incompatibility with your computer. For 

example, I have an address database 

program that was written to run on Mi-

crosoft DOS (pre-Windows). It ran in a 

Command Window in Windows 98 and 

Windows XP but it will not run on my 

Windows 7 64-bit operating system. 

Sometimes you just have to move on 

and grin. 

 

This article has been obtained from 

APCUG with the author’s permission 

for publication by APCUG member 

groups. 
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F 
irefox Search Engine 

Firefox has an add-on called 

CyberSearch which is similar 

to Google Chrome. If you have Fire-

fox try it out. It works like the Google 

Chrome Bar and makes surfing a lot 

easier. How to download it:  

  

Step 1- Download and Install Firefox 

if you don’t have it (http://www.

mozilla.com/en-US/firefox/personal.

html).  

  

Step 2- Download and install the Cy-

berSearch add-on.  Go: https://addons.

m o z i l l a . o r g / e n - U S / f i r e f o x /

addon/7931.  Click the green button 

that says “add to Firefox” to download 

the add-on. 

 

Next, restart Firefox (close and re-

open). CyberSearch is now installed, 

and you now have Google search ca-

pabilities. 

 

Super boost the "Awesome Bar" with 

quick search results that appear while 

you type! This is another addition to 

the Firefox arsenal. 

 

Ballooning 

If you have too many programs open 

at the same time and you are not sure 

of which icon is for which program, 

just hover over an item and a balloon 

should come up telling you what the 

program is.  Oh! You already knew 

that.  :o) 

 

Switching 

An easy way to switch between open 

programs is to hit ALT+TAB. A small 

box will pop up with icons for all the 

currently open programs (even set-

tings windows that don't display on 

the tool bar - like display properties 

for instance). Hold down ALT, then 

simply hit TAB until the window 

you're looking for is highlighted. 

 

Notice that as you tab, the title bar 

information is displayed below the 

The Tip CornerThe Tip CornerThe Tip CornerThe Tip Corner    
by Bill Sheff, Novice SIG Coordinator, Lehigh Valley Computer Group, PA 

www.lvcg.org   nsheff@aol.com 

icons. To go backwards hold down the 

ALT & SHIFT key while hitting 

TAB. 

 

Color Calibration in Windows 7 

Okay, we are not graphic artists – well 

maybe some of us are – but some-

times we do work with print media or 

color-sensitive documents.  So it 

might be worth a few  moments to 

calibrate your monitor what you need 

on the screen, and since every monitor 

is a little different it's always a good 

idea to calibrate!  Here is how:  

 

• Click Start and in the search box, 

type “dccw.exe” without quotes. 

This will bring up the Color Cali-

bration wizard. You'll need to be 

prepared to use the buttons on 

your monitor to properly adjust 

stuff like brightness and contrast, 

but the end result in consistency 

in colors and shade which will 

benefit anyone who wants what 

he sees is what is printed. 

 

Using PowerPoint to Create a 

Crawler Line of Text 

You can use the Crawl In animation to 

create a ticker-like effect on your 

slides. This is good for having infor-

mation continuously scrolling before 

you actually start your presentation. 

What info? Well, for example, your 

name or materials to be required, 

whatever. First, you create the text 

box with the text you need to crawl 

across the screen. Remember, crawls 

are usually a single line of text. Next 

you need to position 

the text box completely off and to the 

left of the slide. If you leave even a 

part of the text box on the slide you do 

not get a complete crawl to finish.  It 

just disappears and then starts over. 

 

For the animation in versions prior to 

2007 go to Slide Show menu, Custom 

Animation choice. In the newer ver-

sions click the Animations tab of the 

Ribbon, click the Custom Animations 

button. 

 

With the pane displayed select the text 

box then click the Add Effect button, 

Entrance category, More Effects 

choice. When the Add Entrance Ef-

fects dialog box opens choose Crawl 

In and click OK. 

 

With that done we need to make ad-

justments to the settings. Click the 

down arrow to the right of the anima-

tion listing in the Custom Animation 

pane. Choose Timing from the list. 

When the Crawl In dialog box opens 

On Click? Choose With Previous? this 

starts the animation as soon as the 

slide starts.  

 

Don’t set the delay until you test it 

out.  Some believe that about 20 sec-

onds works well, it's readable but not 

overly slow. 

 

To permit the crawl to go more than 

once you need to set a Repeat value. 

Choosing End of Slide lets the crawl 

continue as long as necessary. Moving 

over to the Effect tab of this dialog 

box, you'll want to change the direc-

tion to "From Right". Click OK. 

 

Previewing your work should reveal a 

beautiful crawling line of text.  How-

ever you may have to adjust the gap in 

text between run throughs.  What you 

have to do is to create a duplicate of 

the text box after all the animations 

were set.  If you only want the one 

statement then leave the text box as an 

exact duplicate, if not then change out 

the text 

for your second statement. I found 

that this works best when the text is 

about the same length. 

 

For the new text box go back to the 

effect's timing options and set a delay 

time of 10  seconds (assuming that 

you have a 20 second animation).  

 

Lastly, you need to line the text boxes 

up vertically, so that it looks like one 

continuous line of text. If you want 

them to crawl through at different  
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T 
here aren’t too many gadgets 
out there in everyday life that 
you can’t play games on.   Re-

cently I noticed that our Blu-ray DVD 
player has a new category in the net-
work settings for downloading games 
to our TV. What fun! 
 
There’s time wasting games to play on 
your smart phone while waiting in line 
at the post office or DMV (e.g. Angry 
Birds, Solitaire, Mahjongg, etc.).    
 
What I like to call community 
‘shootem up’ games you play on your 
game console, computer, tablet, and 
some e-readers are WOW (World of 
Warcraft), Lord of the Rings, Star 
Craft, Diablo, Heroes of New Earth, 
Halo, Grand Theft Auto. These games 
have huge followings all over the 
world and make it possible for many 
game players to meet and play online 
with their friends and new friends 
from all over. They play these games 
as their created characters and not 
only converse in real time but set up 
mobs (or battle groups) with their 
friends on VOIP sites like Ventrilo -
http://www.instantventrilo.com/get-
v e n t r i l o - s e r v e r . p h p ?
OKEY=google_ivt_ventrilo-b.   
 
My grandson uses an old computer as 
a Ventrilo server and for as little as 
$4.00/month runs groups of as many 
as 10 gamers on these online game 
sites. Many members of his ‘guild’ 
have their own Ventrilo servers and 
can support up to hundreds of players; 
of course, it all depends on how much 
you can afford! 
 
What’s amazing about these gaming 
communities is how much socializing 
goes on outside of the game. Several 
times over the last decade WOW 
friends from as far away as Australia, 
New Zealand, and South Africa have 
visited Southern California to meet 
my son, grandsons and others in the 

locations then move them accord-
ingly. That should do it. 
 

Editing a Document Within the 

Print Preview Window 

If you are print preview a MS Word 
document and suddenly see a mistake, 
what do you do? 
 
Close the Print Preview window, tak-
ing you back to the document where 
you fix the mistake and go back to the 
Print Preview window to double 
check the "look" yet again?  That’s 
what I used to do. 
 
Is there a better way?  That’s why I 
am here.  You can edit in the Print 
Preview window.  While still in Print 
Preview click on the Magnifier button 
on the toolbar, (in Word 2007 Un-
check the Magnifier checkbox on the 
Ribbon). If you want a closer view of 
the text, be sure to zoom in prior to 
using the Magnifier button. 
 
The mouse pointer in the document 
changes to an editing cursor instead of 
the magnifying glass. 
 
Click into the document wherever you 
need to edit and make your changes. 
When you're done editing, turn on the 
magnifying by clicking the Magnifier 
button. This will return you to the 
usual document navigation in Print 
Preview. 
 

This article has been obtained from 

APCUG with the author’s permission 

for publication by APCUG member 

groups. 

The Name’s the GameThe Name’s the GameThe Name’s the GameThe Name’s the Game    
By Jackie Woods, Co-Webmaster, Under the Computer Hood UG (UCHUG), CA  

www.uchug.org   webmasters@uchug.org 

game guilds they’ve met online -- 
mini game conventions! 
 
Then we come to games for the casual 
gamer and there are hundreds out 
there. One of our favorite sites to 
download games is Big Fish games 
www.bigfishgames.com Here games 
are available in every category: puz-
zle, adventure, hidden object, words, 
brain teasers, and card and board 
games. To play these all you need is a 
computer or a smart phone.   
 
If a game console is where you play 
your games, more is available out 
there for active participation. The one 
currently getting raves from players is 

the X-Box 360 Kinect 

which uses a scanning recognition 
technology. There is no mouse or 
game controller needed just your 
movements in front of it. Once I got 
the hang of it, bowling was my favor-
ite but there are many other games 
available. This game console also can 
be used as a pipeline to the web with 
its built-in Wi-Fi, not only for Xbox 
Live, but to Netflix, Pandora, Hulu, 
YouTube, etc. The most common 
price seems to be around $299 – at 
least at the reputable sites like Wal-
Mart and Best Buy. < http://bit.ly/
qIKgXt > 
http://www.xbox.com/en-US/Kinect?
xr=shellnav  
 
Another gaming console pretty popu-
lar with the older generation is the 

Nintendo Wii2.  We’ve all seen the 
commercials of the folks in the retire-
ment home dancing, bowling, playing 
tennis, batting up with the sports and 
entertainment games available. 
 
Like the Kinect this one has a lot of 
interactive features as well, but unlike 
the Kinect you have to have the game 
controller in your hand. Though the 
buzz around the gaming community is 
Nintendo isn’t far behind with the 

(Continued from page 1) 

actually takes much processing power 
so they can easily share a processor. 
Time will tell. 
 
If you do extensive graphics or video 
processing you probably could use the 
multi-core from time to time. 
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Amazon. < http://amzn.to/mPNWzS > 
h t t p : / / w w w . a m a z o n . c o m / b /
ref=bt_atcg_mine_pl_0? 
ie=UTF8&node=2404623011&pf_rd_
m=ATVPDKIKX0DER&pf_rd_s=cen
ter3&pf_rd_r=07H5FJJB7NPNJ9TF
WPS6&pf_rd_t=101&pf_rd_p=12984
21802&pf_rd_i=14218901 

This article has been obtained from 

APCUG with the author’s permission 

for publication by APCUG member 

groups. 

How To Backup SecurelyHow To Backup SecurelyHow To Backup SecurelyHow To Backup Securely    
by Mark Tiongco 

www.geeks.com 

T 
his Tech Tip addresses some 
frequently asked questions 
about how to safeguard your 

computer data on a personal and busi-
ness level. It assumes that you DO 
NOT have gigabytes of music and 
movies that require extensive security 
measures to protect.  
 
1.) How should I begin to secure im-
portant data on my desktop computer 
or laptop? 
 
First, it makes sense to designate 1 or 
2 specific folders on your computer as 
the main folder for confidential file 
back-ups for several reasons. If you 
have to do a quick back-up, all you do 
is copy that folder to an external drive 
for an instant back-up.  
 
Second, It provides a centralized loca-
tion for all important data. Instead of 
having to hunt down the menu, sub-
menu, sub-sub-menu of where you 
normally download company financial 
spreadsheets, you can set your 
browser and programs (such as Quick-
books, etc.) to save/download all im-
portant files to this folder.  
 
Third, let’s say you only save ALL 
important files on a flash drive/
external hard drive. If your notebook 
gets lost/stolen, the thieves only have 
the programs and not the actual confi-
dential files which are on the cheap 
flash drive.  
 
2.) Great, now how do I actually back-
up my designated BACK UP folder
(s)?  

controller-less console. This machine 
has basically the same kind of games 
available as the other consoles. Each 
machine does have certain games that 
are just for a particular platform, but 
most are out there for all of them. The 
Wii does have extra bling available in 
the form of the U-Draw 
tablet ($70), the Wii Fit bundle with a 
balance board ($94.99) and for $40 the 
Wii Plus controller. So like most of 
these consoles you do pay quite a bit 
more to get those extras. The basic 
Wii runs $129.99 with the Mario Kart 
Bundle – and a lot more once you start 
adding goodies. Oh, and another little 
note, to stream from Netflix, etc. you 
need a special disc! More $$.< http://
bit.ly/kM8XZl > http://www.nintendo.
com/?country=US&lang=en 
 
Sony is the other big game console 

maker with its PlayStation 3 320GB 

Edition. Once again pretty much the 
same as the other consoles: has Wi-Fi, 
streams from various sources such as 
Netflix, Blockbuster, etc., and has a 
built-in Blu-ray player (very handy if 
you don’t already have one) and is 
also set up for HDMI. Unlike Xbox 
Live, the PlayStation Network is free, 
and should be with the basic cost of 
this console at $359.99 on www.
Amazon.com 
 
Nintendo also has a mini game player 

with the Nintendo 3DS, which is a 
great little touch screen 3D device at 
$169.99. It has Wi-Fi and Internet 
available. My grandson uses it more 
like a tablet than a game machine. < 
http://amzn.to/otx1Pp > http://www.
amazon.com/Nintendo-3DS-Aqua-
Blue/dp/B002I090AG/ref=sr_1_7?
ie=UTF8&qid=1314928559&sr=8-7 
 
So those are the big three (and pint 
size) of the gaming consoles. Gaming 
has gone through various changes over 
the last 40 years since the Atari 5200, 
which I used to think was the cat’s 
meow back in the 70’s.  
 
Following is the link to Motion Gam-
ing 101. This will give you a compre-
hensive video tour of each courtesy of 

Here’s where it gets tricky. You have 
several back-up options such as:  
 
A.) Cloud – Services such as Car-
bonite and Mozy offer low-priced 
back-up solutions. You basically up-
load all your confidential files to their 
cloud servers and are able to access 
them anywhere in the world where 
there is Internet access. The main is-
sue is that, from a business security 
perspective, you have no idea where 
your data is stored. If, for example, 
it’s stored in a server farm in China 
which gets hacked, then you’re in 
trouble. 
 
B.) External Hard Drives – These 
nifty devices come in portable 2.5” 
and larger 3.5” flavors and offer more 
than generous dumping grounds for 
all things important. Once you plug it 
in, your OS recognizes it and pops 
you up with a folder showing it as a 
(giant) external drive with a letter (i.e. 
G:) Some even feature OTB (One 
Touch Backup) so you press one but-
ton and it backs up either your entire 
system or certain portions of it. Some 
external hard drives offer plug-in en-
cryption that prevents unauthorized 
access. The issue with this solution is 
that you have to lug it around, which 
means it has a chance of getting lost/
stolen and the formality of performing 
a back-up might become time-
consuming to some.  
 
C.) Flash Drive – These little drives 
are more nimble, have zero moving 
parts and are highly portable. Unfortu-
nately, this is also its Achilles’ Heel as 
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Word 2010 Ribbon CustomizationWord 2010 Ribbon CustomizationWord 2010 Ribbon CustomizationWord 2010 Ribbon Customization    
by Lynn Page, Editor / Webmaster, Crystal River Users Group, FL 

www.crug.com        editor@crug.com 

of multiple back-up solutions and pro-
active behavior. For example, it would 
be a good idea to store important sen-
sitive data on your flash drive and en-
crypting it with TRUE Crypt while 
also saving duplicate file copies on 
your home NAS drive via secure VPN 
connection. If your flash drive is lost/
stolen, True Crypt prevents the drive 
from being used without proper cre-
dentials and you can still access the 
very same duplicate files on your 
NAS server.  
 
Regarding proactive behavior, you 
should be mindful of back-ups so you 
don’t lose something you wish you 
saved 2 weeks ago.  
 
There are also programs out there that 
can help secure data such as:  

• Folder Lock – Locks and can hide 

any folder you wish from prying 
eyes.  

• True Crypt– secures drives with 

extensive hardware encryption. 

• Acronis Drive Cleaner – Com-

pletely erases all drive data with 
several methods (DoD, Gutmann 
method, etc.) – works great if 
you’re planning to get rid of old 
computer hardware. 

 
Remember, it’s all about being proac-
tive and being mindful of what back-
up security solutions to use for your 
personal or business needs. 
 

This article has been obtained from 

APCUG with the author’s permission 

for publication by APCUG member 

groups. 

� � � � � 

its relatively small size makes it prone 
to becoming misplaced or stolen. Also 
it does not have the capacity of a lar-
ger external drive. The good news is 
that some flash drives have built-in 
encryption which can be useful if it 
lands in the wrong hands.  
 
D.) Home/Office Network Attached 
Storage Drive – Also called NAS, this 
is an excellent solution for compre-
hensive back-up protection as these 
hard drives function as dumping 
grounds for an entire home or office 
network. It provides a centralized lo-
cation for files, folders and documents 
which any connected computer can 
access and come in large drive sizes. 
However, security precautions should 
be utilized if the NAS has built-in 
measures as an unsecured NAS may 
be prone to prying eyes. For example, 
a NAS without security protocols acti-
vated while connected to a home Wi-
Fi network is prone to being breached. 
Because of this, it’s crucial to config-
ure the NAS security as well as the 
router/network security for optimal 
protection. 
 
E.) Backing up to CD/DVD/Blu-
Ray – Optical media back-up is actu-
ally a very cost-effective solution be-
cause CDs and DVDs are very cheap 
nowadays. Furthermore, if you’re 
looking to close the books for a cer-
tain month on your business, burning 
to a CD-R or DVD+R sets the data in 
stone so it can’t be manipulated on the 
disc. The problem is that if you have 
lots of data to back-up, the formality 
of using several CD-R or DVD-R 
discs to save might also become time 
consuming. In addition, you would 
have to make sure said back-up discs 
are placed in a safe place where the 
chance of it getting stolen is mini-
mized. 
 
3.) Which back-up method should I 
pick?  
 
While the above solutions offer many 
ways to back up your confidential 
data, the best way to minimize a data 
breach/loss is to follow a combination 

F 
or those new to Office 2007 or 
2010 perhaps the most confus-
ing item is the Ribbon inter-

face. I remember how I felt when I 
first moved to Office 2007. The con-
fusion that the Office Button created 
has been eliminated in Office 2010 
with the introduction of the File Tab. 
So it is no longer difficult to find the 
normal File menu commands. This 
month I will take a look at customiz-
ing the Ribbon. Office 2010 lets you 
personalize the Ribbon the way you 
want it. However the customization is 
specific to that particular Office 2007 
application. The default tabs and 
groups can be renamed and rear-
ranged. New custom 
tabs can be added and new custom 
groups can be added to a tab. 
    

Open Ribbon Customization  
To customize the Ribbon select the 
File tab and then Click Help. In the 
Help pop out menu click Options in 
the Tools for Working With Office 
section. In the Word Options dialog 
box select Customize Ribbon. The 

dialog box shows the options for cus-
tomizing 
the Ribbon. The left column contains 
commands that can be added to the 
Ribbon. The right column shows what 
is already on the Ribbon.  
 

Rearrange or Reorganize the Ribbon  
Built in Office 2010 default tabs and 
groups can be renamed and reordered 
but default commands cannot. To 
change to position of a tab click and 
drag it up or down in the right col-
umn. Here I have moved the View tab 
above Mailings and Review and its 
tab is before them on the Ribbon. 
 
Groups on a Tab are rearranged in the 
same manner. 
 

Add a New Tab or Group  
New Tab 
If you always use the same few but 
diverse commands and want them eas-
ily assessable in one location create a 
new tab and place the commands 
there. In the right column select the 
tab the new tab is to follow and click 
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Member  Classified Member  Classified Member  Classified Member  Classified 

AdsAdsAdsAds    
 

s end   any  classifieds  to the  
WYSIWYG   Publisher  at the 
club’s  PO  Box,  or  to  his       

e-mail address posted  on page 2 of 
the newsletter.  
 
Ads are available to SHCC members 
and are limited to computer related 
items for non-commercial purposes. 
There is no charge for members 
classified ads.  

� � � � � 

CCCClub Record Changeslub Record Changeslub Record Changeslub Record Changes    
 

T 
o update your e-mail address, 
phone number, etc., please      
e-mail the club secretary at: 

Secretary@SterlingHeightsComputer 
Club.org. Using this address will pro-
vide the smoothest and quickest venue 
for any changes. 

� � � � � 

Presenters WantedPresenters WantedPresenters WantedPresenters Wanted    
 

T 
he officers invite any member 
to make a presentation at the 
main meeting. 

 
If there is some software you have 
been using and think others may be 
interested as well, or there is a 
computer topic you would like to 
present to other members, please call 
or e-mail Don VanSyckel. Making 
presentations is not that difficult.  The 
hour goes by before you know it and 
there is always enough material to 
cover in a software package so that 
the hour is easy to fill. 
 
If there is a topic you are interested in 
or something you would like 
demonstrated, please see any of the 
officers.  They are always interested 
in what the members would like to 
see.    

� � � � � 

Last Month's MeetingLast Month's MeetingLast Month's MeetingLast Month's Meeting 
 

Last month Michael Bader presented 
"Windows 8 – A First Look". What a 
first look it was. It will be interesting 
to see where Microsoft takes this one. 
Windows 8 is heavily influenced with 
tablet PCs and touch screen input. 
Thanks Michael for this preview. 

� � � � � 

the New Tab button at the bottom of 
the column. Change the name of the 
new tab or new group select it and 
click the Rename button.   
 

New Group  
Add new groups to existing tabs in a 
similar fashion. Select the tab or a 
group in the tab and click the New 
Group button. If a tab was selected the 
new group is added at the end of the 
groups for that tab. If a group was se-
lected the new group is positioned be-
low it. Rename the group giving it a 
descriptive name by clicking the Re-
name button.  
 
Adding a new group is important be-
cause to add new commands they 
must be placed in a new custom 
group. Again I don’t feel the need to 
add new groups but for those who 
miss quick access to particular com-
mands this is a good option.  

 

Reset  
The Reset button is a safety feature. It 
removes all customization and reverts 
the Ribbon to the defaults settings.  

 

Add or Remove Items  
Remember that to add commands  to a 
group; you need to add a custom 
group to a default tab or to a new, cus-
tom tab. The custom tabs and groups 
in the Customize the Ribbon list have 
(Custom) after the name. However, 
(Custom) doesn’t show on the ribbon.  
To add a command locate and select it 
in the left column. Click the down 
arrow by Popular Commands to open 
a drop down menu for help in finding 
a command. 
 
Select the custom group the command 
is to be added to and then click the 
Add button between the columns. The 
command is added the bottom of the 
group. If a command in the custom 
group is selected the new command is 
added below it.  
 
To remove a custom tab, custom 
group or command in a custom group 
select it in the right column and click 
the Remove button. If a custom tab or 

group is deleted all nested groups and 
commands are also removed from the 
Ribbon.   
 

Example  
I really don’t have a problem with the 
default Ribbon. I did reorder the tabs 
to show how it is completed. I do have 
one Favorite command and that is 
Paste Special. The  clipboard group on 
the Home tab makes Paste Special 
much handier then in other versions 
but for an example I used it as an 
added command. 
 
First I added a new custom Paste 
group on the Home tab after the Clip-
board group. Next I filtered the com-
mands to those on the Main tab. 
Opening the Clipboard and then the 

Paste group showed the actual Paste 
Special command. With my custom 
group selected in the right column I 
selected Paste Special in the left panel 
and clicked the Add Button. Then I 
also added the Paste command and 
finally clicked OK. Now Paste 
Special is a single click operation. 
 
Notice that the View tab is before the 
Mailings and Review tabs and the new 
Paste group contains Paste Special 
and Paste.   
 

This article has been obtained from 

APCUG with the author’s permission 

for publication by APCUG member 

groups. 
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 WYSIWYG WEB WATCH (wwwWYSIWYG WEB WATCH (wwwWYSIWYG WEB WATCH (wwwWYSIWYG WEB WATCH (www) 
By Paul Baecker 

webwatch@sterlingheightscomputer 

club.org 

This column 

attempts to lo-

cate sites con-

taining valuable, 

amusing and 

free content, 

with no over-

bearing pressure 

to purchase any-

thing.  Send your favorite entertain-

ing, helpful or just plain useless sites 

(a description is optional) to the e-

address noted above, for inclusion in a 

future WYSIWYG issue.  Also check 

the SHCC web site (“Web Page Re-

views”) for previous gems.   

� � � � � 

Thomas Edison began creating re-

cordings using tin foil in 1877 and 

wax cylinders in 1896.  Here is a col-

lection of sound recordings from that 

era. 

h t t p : / / w w w . n p s . g o v / e d i s /

photosmultimedia/the-recording-

archives.htm 

 

Website devoted to interesting events 

in US History – facts, myths, trivia, 

common items origins, accidental in-

ventions, more. 

http://www.interestingushistory.com 

 

Free utility to remove malware be-

longing to the family Rootkit.Win32.

TDSS (aka Tidserv, TDSServ, 

Alureon).  This is one to add to your 

PC tool box.. 

http://support.kaspersky.com/viruses/

solutions?qid=208280684 

 

A portion of the vast cache of Na-

tional Geographic’s photography.  

Select ‘Galleries’, ‘Photo of the Day’, 

or ‘Wallpapers’ 

h t t p : / / p h o t o g r a p h y .

nationalgeographic.com 

 

Hover over the first triangular illustra-

tion to see what happens, and then 

move to the next illustration and    

repeat. 

http://www.interactivetriangulation.

com 

 

Community-specific news and infor-

mation platform dedicated to provid-

ing comprehensive and trusted local 

coverage for individual towns and 

communities 

http://www.patch.com 

 

Collaboration among the historical 

agencies of the greater Rochester, MI 

area depicting some of the oldest 

structures in Oakland County. 

http://oaklandregionalhistoricsites.org 

 

Strives to discover and uncover 

“awesome” events, businesses, music, 

people, places, products, etc. — any-

thing that the Great Lakes State has to 

offer. 

http://www.awesomemitten.com 

 

Free tool for non-technical computer 

users who want to create an attractive, 

professional-looking web site without 

needing to know HTML or web cod-

ing 

http://kompozer.net 

 

Supports Michigan agriculture with 

sources for product purchasing, sug-

gested in-season produce, farm news, 

more. 

http://www.selectmichigan.org 

 

Don’t want to reveal your real e-

address when signing up for some-

thing?  Use a Mailinator e-address and 

retrieve their return mail.  Saves mail 

for one day. 

http://mailinator.com 

 
Network of scenic webcams offering a 

complete searchable database of interest-

ing places and views from around the 

world.   

http://www.earthcam.com 

 

Free differencing and merging tool for 

Windows. WinMerge can compare 

both folders and files, presenting dif-

ferences in a visual text format that is 

easy to understand and handle. 

http://winmerge.org 

 

Linux system rescue disk is available 

as a bootable CD-ROM or USB drive 

for administering or repairing your 

system and data after a crash.  It aims 

to provide an easy way to carry out 

admin tasks on your computer, such 

as creating and editing the hard disk 

partitions and potentially saving data.  

When your Windows system crashes, 

you will be thrilled that you have this 

CD in your tool box. 

http://www.sysresccd.org 

 

Select a decade time capsule and view 

its fashion, culture, art and politics in 

photos. 

http://www.retronaut.co 

 

Simple method for zooming in around 

the world.  Just use the mouse scroll-

wheel. 

http://godsmouse.com 

 
Touristic webcams worldwide.  Some of-

fer live-action views, others offer archived 

activity. 
http://www.webcams.travel 

 

Wayne County, MI site shows real-

time locations of salt trucks and which 

roads they’ve plowed most recently. 

http://compass.waynecounty.com 

 

You, too, can create art like Jackson 

Pollock.  Click mouse to change col-

ors.  Save (and sell?) your creation by 

printing to a .pdf file. 

http://www.jacksonpollock.org 

 

Someone’s list of the fifty worst mu-

sic videos ever created.  Watch them 

and then you decide. 

http://www.nme.com/list/50-worst-

music-videos-ever/253198 



 

STERLING HEIGHTS  

COMPUTER CLUB 
PO Box 385 

Sterling Heights, MI 48311-0385 
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